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Introduction 

The gopher tortoise (Gopherus polyphemus) is legally protected in the six U.S. states where it 

occurs. Populations west of the Mobile-Tombigbee Rivers have been federally-listed as 

threatened since 1987 and those in the eastern portion of the range recently were found to 

warrant candidate status as threatened (U.S. Fish and Wildlife Service, 2011). Although threats 

to the species vary regionally, there is a critical need for information on the status and trends of 

populations across the range. This workbook outlines standardized methods for gopher tortoise 

surveys using line transect distance sampling methodology (Buckland et al., 2001) and builds 

upon methods described in the Gopher Tortoise Survey Handbook (Smith et al., 2009).   

Line transect distance sampling (LTDS) is a widely-used method to estimate population size 

and density of wildlife species (Buckland et al., 2001). It is an efficient, statistically robust 

method that relies on counting objects observed from transects and measuring the distance from 

transects to each object.  The method assumes all objects on the transect are detected but allows a 

proportion of objects to be missed, based on the fact that an observer’s ability to detect an object 

decreases with distance from the transect (Buckland et al., 2001; Fig. 1). LTDS relies on five key 

assumptions: 1) all objects directly on the transect are found; 2) objects are detected at their 

initial location, prior to any response to the observer; 3) transect length is measured accurately; 

4) distance from the transect to the object is measured accurately; and 5) transects themselves, or 

systematic placement of the transects, is random (Buckland et al., 2001). For a detailed 

explanation of how LTDS differs from spatially constrained survey methods like strip transect 

sampling see Buckland et al. (1993), Buckland et al. (2001), and Nomani et al. (2008). 

  

 

When using LTDS for gopher tortoises, the search objects are tortoises above ground and 

occupied burrows (as determined using a camera scope). The burrow entrance serves as the 

location of the individual, and the number of tortoises observed, either above ground or in 

burrows, is used to calculate a population estimate.  Since burrow width varies with tortoise size, 

and the smallest burrows are difficult to detect, this method provides an estimate of subadult and 

Figure 1. Representation of the results 

of distance sampling along a line 

transect. The method assumes all 

objects on the transect are detected, 

but allows for decreasing detection 

with increasing distance from the 

transect.  
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adult population size.  We recommend using burrow width as a covariate in models to adjust for 

differences in detection probability. There is also a potential source of error associated with 

scoping burrows. For example, an observer may be unable to reach the end of the burrow with 

the camera scope because of obstructions (roots, debris, or presence of water), may fail to 

observe a second tortoise in a burrow, or may falsely classify an occupied burrow as unoccupied. 

The first two sources of scoping error are unavoidable with the current technology, but errors due 

to misclassification of occupancy can be minimized with proper training in use of a camera 

scope. Scoping error (percent of burrows for which occupancy was unknown) should be reported 

with survey results.  

Gopher tortoises occur in low densities relative to many other wildlife species and their 

burrows are generally not evenly distributed across suitable habitat. Therefore, use of multiple 

observers can increase the number of observations over the typical one observer method 

(Buckland et al., 2001). With a three observer approach for gopher tortoise surveys, one observer 

navigates the transect searching for burrows and tortoises on or near the transect, and the other 

two observers search on either side of the transect to increase the total number of detections 

(Figs. 2a &b). Having three observers not only increases the number of detections, but also is 

helpful for carrying field equipment and scoping burrows. However, care must be taken to ensure 

objects between the center and outside observers are not missed. 

 

 

 
 

 

 

The open source software Program Distance ver. 6.2 (http://www.ruwpa.st-

and.ac.uk/distance/, Thomas et al., 2010) can be used to create LTDS survey designs and to 

analyze data in a variety of ways. ArcGIS software can be used to create and manage spatial data 

[e.g., to define the survey area (sampling frame), transect, and tortoise locations].  The methods 

outlined in this workbook address the major steps to obtain population estimates for gopher 

tortoises under most circumstances using conventional LTDS. We present an example using 

Figures 2 a&b.  Comparison of the number of detections using one versus 

three observers for distance sampling. 
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LTDS to estimate population size for a 222 ha site with a moderate density of tortoises.  In 

special cases, e.g., large or very small sites where tortoise densities are extremely low, methods 

other than conventional LTDS may be appropriate. We assume that users of this workbook are 

familiar with ArcGIS, basic statistical principles, and have knowledge of the ecology of the 

gopher tortoise (including how to identify suitable habitat and burrows). We strongly encourage 

anyone using this workbook to review relevant chapters in the Introduction to Distance Sampling 

(Buckland et al. 2001) and Distance Sampling (Buckland et al. 1993) to gain an understanding of 

the theoretical and practical underpinnings of the method.  Field technicians using this method 

must have an understanding of the importance of meeting the assumptions of LTDS described 

above, and should be proficient in field survey methods and use of all equipment. Quality control 

and oversight of data collection, management, analysis, and interpretation are critical. 

The major steps in achieving a population estimate for gopher tortoises using LTDS are 

described below and are followed by examples in Appendix 1 that illustrate how to design a 

gopher tortoise survey and analyze survey data using Program Distance. Step-by-step worksheets 

for designing a survey and analyzing data, including how to interface between ArcGIS v.9.3, 

Microsoft Excel, and Program Distance ver. 6.2, are included in Appendix II. The latter material 

may become obsolete as software is updated.  

 

Methodology 

Delineation of Sampling Frame.  The sampling frame is the area for which you wish to 

estimate the tortoise density and population size.  For most purposes, the sampling frame is the 

extent of suitable tortoise habitat on a particular property as determined by soils, vegetation (land 

cover), and past and present land-use. In some situations, it may be desirable to stratify the 

sampling frame to determine tortoise density in different habitats within the same site (e.g., 

sandhill vs. flatwoods habitat, which might have different tortoise densities); in this case, 

systematic stratified sampling (e.g., by habitat type) can be used to minimize within-stratum 

variability. Once a decision is made on the extent of the sampling frame, ArcGIS can be used to 

create a shape file of the sampling frame.  

 

Pilot Survey. The purpose of a pilot survey is to collect preliminary data on tortoise 

abundance to estimate the sampling intensity needed for the full LTDS survey. From the pilot 

survey data, the length of transect surveyed per tortoise observation, called the tortoise encounter 

rate, is calculated (Buckland et al., 2001, page 240). There is flexibility in the amount of effort 

required for a pilot survey and in selecting locations for pilot survey transects, but it is important 

that the pilot survey captures variation in habitat type, quality, and tortoise distribution within the 

sampling frame. Thus, we recommend random placement of pilot survey transects to minimize 

potential bias. We also recommend sampling a series of short transects, e.g., 10-20 transects that 

are 200 m long, across the sampling frame. Large sites or sites with very low tortoise densities 
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may require sampling additional pilot survey transects to ensure that you capture variation in 

tortoise distribution across the entire sampling frame. To increase efficiency, particularly on 

large sites, pilot survey transects can be configured in a “U-shape”, such that 500 m is sampled at 

each random location (see Appendix I, Example 1, Step 2). If no tortoises are observed on the 

initial round of pilot survey transects, it will be necessary to survey additional transects because 

at least one tortoise observation is required to calculate an encounter rate.  Pilot surveys can also 

be used to assess the accuracy of the sampling frame, which can be adjusted if necessary. 

   

Full Survey Design The full LTDS survey is designed using Program Distance and 

incorporates the sampling frame and tortoise encounter rate from the pilot survey. The tortoise 

encounter rate (meters of transect sampled per tortoise observed) is used to extrapolate the total 

length of transect necessary to observe enough objects (tortoises) to derive abundance estimates 

with reasonable precision (see Buckland et al., 2001, page 242; Buckland et al., 2004). As a 

general rule, to detect changes in population size over time, sampling should be intensive enough 

to detect >60 tortoises and produce a coefficient of variation (CV) of 15-20%, which is a 

practical expectation for most monitoring projects. If the CV exceeds 20%, the statistical power, 

confidence limits, and ability to detect trends in monitoring data are substantially reduced. 

The survey design also takes into consideration some basic characteristics of the habitat 

within the sampling frame. In large areas of relatively homogeneous habitat, a systematic 

random survey is the most efficient design. In a systematic random survey, the beginning of the 

first transect is randomly placed, satisfying the statistical condition for a random sample, and 

transects are parallel and spaced a fixed distance apart. For large parcels of habitat (>10,000 ha), 

a systematic segmented grid or a systematic segmented trackline could be used to disperse the 

sample over a large area (Buckland et al., 2001). In either case, transects should be oriented 

perpendicular to topographic contours and parallel to any known gradient, if possible. 

For extremely small tortoise populations “repeated surveys” can be used to obtain sufficient 

observations of tortoises to estimate population size (Buckland et al., 2004).  In repeated surveys, 

the same transects are re-sampled with independent observers and the data can be pooled to 

derive an abundance estimate. Alternatively, sample size can be increased by sampling two sets 

of perpendicular transects and pooling the data to derive an abundance estimate (Stober and 

Smith, 2009). In some circumstances, e.g., when there are fewer than 10 tortoises on a small tract 

of land (< 100 ha), a total count survey using a double-observer method should be considered 

(Nichols et al., 2000; Nomani et al., 2008).  

 

Full Survey LTDS implementation:  

Data collection. Data for long term gopher tortoise monitoring efforts will be collected 

infrequently and consistency in data collection is critical. Therefore, it is important to clearly 

define metadata associated with a project and to use pre-prepared datasheets (paper or electronic) 
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to ensure consistency in data collection. For conventional LTDS surveys, the minimum data 

collected in the field includes date/time, transect ID (unique to each transect), transect length, 

observations of tortoises (within and outside of burrows), perpendicular distances from the 

transects to burrows/tortoises, and burrow width or tortoise length. Transects can be delineated in 

the field using a compass and measuring tape. However, the best technology currently available 

for collection and management of spatial data is a field computer with a Global Positioning 

System (GPS) capable of real time data correction and an antenna with sub-meter accuracy, and 

with ArcPad and/or ArcGIS software. If a field computer/GPS is used for data collection, point 

data are collected at each observation and the perpendicular distances from transects to tortoises 

and burrows can be calculated later using ArcGIS. With a field computer, an electronic datasheet 

with pull down menus can greatly reduce data entry errors; however, prior to analysis all field 

data should be carefully reviewed for errors. For gopher tortoise population surveys using LTDS, 

we recommend collecting the following data listed below:  

 

 Date/Time 

 Transect #:  Unique ID of transect. 

 Transect Length (m): The total length of each transect. This can be calculated using 

ArcGIS if transect start and end points are collected in the field with a GPS unit with sub-

meter accuracy. 

 Perpendicular Distance (m):  The perpendicular distance from any tortoise observed 

above ground (at location where they were first observed) or the burrow entrance to 

thetransect.  This can be calculated using ArcGIS, if locations are collected in the field with a 

GPS unit with sub-meter accuracy. Only data from occupied burrows or tortoises observed 

above ground will be used in analyses. 

 Burrow Width (cm):  a measurement of the width of each burrow taken approximately 

50 cm inside the opening.   If a tortoise is observed above ground, carapace length (in cm) 

should be entered in this field. 

 Burrow scoped (Yes or No): Record whether you attempted to scope each burrow.  If 

not, explain why in the “Notes” field. 

 Burrow occupancy (Yes, No, or Unknown): Record occupancy as “Yes” if a tortoise is 

observed above ground or in a burrow; or “No” only if you are able to search to the end of 

the burrow and no tortoise is observed. Record occupancy as “Unknown” if you cannot 

clearly see the end of the burrow, and include an explanation in the “Notes” field.  Be aware 

that tortoises can occupy flooded burrows or burrows packed with debris. It is important to 

record “Unknowns” as this is a source of potential error. 

 Commensals: Record observations of other burrow inhabitants, such as Florida gopher 

frog. 
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 Notes:  This field can be used to record why you did not scope a burrow; additional 

comments, or notes. 

 

Field Sampling- single observer method. Line transect distance sampling typically involves one 

observer searching along a transect and recording all objects seen from the transect. When using 

a GPS/field computer as described above, the observer can navigate to the transect and take a 

GPS point at the starting point. While walking the transect, each time a burrow or tortoise is 

observed, a point is taken in the GPS, burrow width or tortoise length is measured, and if 

necessary, a camera scope is used to determine whether or not a tortoise is present in a burrow.  

Care must be taken if the observer leaves the transect so that no objects on or near the transect 

are missed. At the completion of each transect an endpoint is taken with the GPS; the actual 

length of transect sampled can be calculated later in ArcGIS. If a transect crosses unsuitable 

habitat, such as a wetland, this should be clipped out of the total length of the transect to avoid 

biasing the sample.  When using a tape measure and compass for LTDS, the observer must 

measure the perpendicular distance from the transect to the burrow opening or above ground 

tortoise and transect length as accurately as possible (±0.5 m).   

 

If possible, we recommend using a second person to follow behind the primary observer and 

assist with scoping burrows. The second person can follow directly behind the first observer and 

search for burrows the first observer might have missed; observations should be recorded as 

either first or second observer. This is a double-observer approach can yield a more precise 

population estimate than a single observer approach (Nichols et al., 2000; Nomani et al., 2008)  

 

Field Sampling- three observer method. The most efficient means of conducting LTDS surveys 

for gopher tortoises is to use three observers along with the GPS/field computer described above 

(Stober and Smith, 2009). Transect start and end points and observations of tortoises and 

burrows should be recorded as with the single observer method and all burrows should be scoped 

to determine whether a tortoise is present.  But with a three observer approach, one observer 

navigates the transect using the GPS/field computer and observes tortoises or burrows on or near 

the transect. The other two observers walk on either side of the transect searching for tortoises 

and burrows from the transect outward. The outside observers should be sure to detect all 

tortoises and burrows between themselves and the transect centerline, but they may also detect 

objects to the outside. Thus, using three observers increases the number of observations and the 

effective strip width of the transect (Fig. 2b).  The distance between the center line observer and 

two outside observers may vary slightly depending on the visibility within the habitat.  But 

ideally outside observers should maintain a distance at which they are certain to see any burrows 

or tortoises between themselves and the centerline (3-5 m in most habitats).  
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APPENDIX I 

 
INSTRUCTIONS FOR LTDS SURVEY 

DESIGNS USING PROGRAM 

DISTANCE ver. 6.2 
 

 

 Creating a Conventional Design (Pages 11-16) 

 

 Creating Designs for Special Cases 

 

1. Repeated Sampling Design (Pages 17-19) 

 

2. Systematic Segmented Grid Sampling Design 

(Pages 20-21) 
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CREATING A CONVENTIONAL SURVEY DESIGN 
 

 

A conventional survey design is the simplest approach to a LTDS survey and is appropriate for 

sites that are of moderate size with relatively homogeneous habitat and moderate to high 

numbers of gopher tortoises.  Examples of more complex survey designs (e.g., for sites with low 

numbers of tortoises will follow). 

 

There are a number of different ways to approach designing a survey using LTDS.  We use 

ArcGIS to create and manipulate shape files needed for the design and data collection, and 

Program Distance to generate survey transects based on the pilot survey results.  The methods 

below focus on the steps in Program Distance ver. 6.2, and provide limited guidance in ArcGIS, 

assuming the user has some familiarity with GIS software.  Users with more experience in 

Program Distance and ArcGIS may elect to take a different, but equally valid, approach to 

designing a survey.  Also, be aware that software versions may change rendering some of the 

steps in this workbook obsolete. 

  

1. Preparing the Sampling Frame for import into Program Distance 

To bring the sampling frame shape file into Distance, it must be given a specific name 

(“study_ar”) and the shape file must fit a very specific format.  To do so, make a copy of the 

sampling frame shape file and name it “study_ar”.  Since a shape file consists of multiple sub-

files, it is easiest to copy and rename the file in ArcCatalog. Then go to the Editor in ArcGIS 

and select Start Editing the “study_ar” shapefile.  Open the attribute table and select all rows in 

“study_ar”.  In Editor, select Merge and then Stop Editing and Save edits.  Open the attribute 

table again and add a field called “LinkID”, and specify the field Type as Short Integer, with 

Precision of “0”.  Next, in the attribute table, delete all fields except “FID”, “Shape”, and 

“LinkID”.  Next, right click on the “LinkID” field and select Field Calculator.  You will get a 

warning message that “you are about to do a calculation outside of an edit session.”  Select Yes 
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to continue.  In the Field Calculator window, under “LinkID” =, enter a “1” and then select 

OK.  

 

Your final attribute table for the study_ar shape file should look like this: 

 

FID Shape LinkID 

0 Polygon 1 

 

 

 

2. How to create a Project in Program Distance 

Once you have a study_ar shape file in the proper format, you need to create a new Project in 

Program Distance and specify where you wish to store the project files on your computer. 

 

Open Program Distance. Select the Tools option on the task bar and then select Preferences.  

Under the General tab, select the Browse button to set the Default project folder.  Once you 

have selected a location for the files, select the OK button at the bottom of the window. This 

returns you to the main menu. 

 

From the main menu, select the File tab and select New Project. In the Create Project Window, 

enter your file name; for the purposes of this exercise, name the project “Balfour_design”. After 

naming your project and choosing a location to store it, check the box to “Save this folder as the 

default for Distance projects.”  Then select the Create button. This opens a window with the 

New Project Setup Wizard. In Step 1-Type of Project: select Design a new survey, and then 

the Next button. This takes you to Step 2- Setup for Designing Surveys: select the Finish 

button. You need to close the project at this point so that Program Distance can create a folder to 

store your sampling frame shape file (“study_ar”). Close the project by selecting the File tab at 

the top of the screen and then selecting Exit and then Yes. 
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The next step is to copy your sampling frame shape file, “study_ar”, to the data folder called 

“Balfour_design.dat” that Program Distance automatically created for you. To do so, use 

Windows Explorer.  Remember to copy all 6 of the “study_ar “files that make up the shape file 

(study_ar.dbf, study_ar.prj, study_ar.sbn, study_ar.sbx, study_ar.shp, and study_ar.shx).  Copy 

and paste these files into the “Balfour_design.dat” folder.  You will notice that there are already 

3 files in “Balfour_design.dat” folder.  These files are automatically created by the software 

when you created a new project and you will overwrite/replace all three of these files with your 

own files. 

 

3. Creating a Map in Program Distance 

Next you will create a map in your Distance Project using the “study_ar “shape file.  This will 

display your sampling frame in Program Distance.  Open your Distance project by double 

clicking on the project file in Windows Explorer (look for the Distance icon followed by your 

project name:  ).   

 

Select the Maps tab within the Project Browser. If you slowly run your cursor across the icons 

on the tool bar under the Maps tab, text bubbles will pop up explaining what each icon does.  

Select the New Map icon.  You will notice a New Map, highlighted in blue appears as the first 

row under Name. Then select the View Map icon. Select the icon to Add Layer to Map.  This 

will open a window automatically allowing you to add your Study area (“study_ar” shape file). 

Select OK. Then close out of the Maps window by selecting the black X in the right corner of 

the screen (not the top red X, which closes the Project!).  The Confirm save map changes 

window will appear, select Yes. 

 

Go to the Data tab within the Project Browser to create a “grid” layer that will be used for 

transect placement. Right click on Study area located under the Dater layers window on the left 

side of the screen.  Select Data layer Properties, then the Geographic data tab.  This opens the 
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Coordinate System window. Select the Change coordinate system button in the lower right 

side of the window.  Select the pull down tab to the right of Geographic coordinate system, 

scroll up and select [None].  Select the OK button to close this window and then select the OK 

button to close the Data layer properties window.  

 

Next, right click on Study area again and select Create Data Layer.  Change the Layer name 

to “grid”.  Keep the default Study area under Parent Layer. Change the Layer type to 

Coverage using the pull down tab.  Select the Properties button next to Layer type to open the 

Grid Properties Window. The Projection for grid calculations should be set to “[None]”, 

change the Distance between grid points from “100” to “40”. A rough rule of thumb is that grid 

spacing should be equal to the transect strip width (40 m for tortoise surveys). You may have to 

choose larger grid spacing for large sites because using transect width could create 10’s of 

thousands of grid points. In these cases, you would want to choose a larger grid spacing 

(Distance 6.2 Help Guide).  The Units of distance should be set to “Meter”. Select OK and then 

Yes to confirm adding grid points.  

 

The next step is to add the “grid” layer to your map.  Go to the Maps tab on the Project Browser 

and select the View Map tab.  Select the Add Layer to Map icon.  Select OK to add the “grid” 

from the Add Map Layer window.  Close out of the Maps window by selecting the black X in 

the right corner of the screen. Select Yes to save changes. 

 

4. Creating a Conventional Design 

Go to the Designs tab within the Project Browser (next to the Maps tab).  Select the New Design 

icon and notice that a design named “New Design” appears in the first row in the main window 

(highlighted in blue). To set up your design, either select the Show details for selected design 

icon or double click the gray ball next to ID.  Name this design “conventional”. Under the Type 

of Design, Sampler, select Line from the pull down menu.  Below that, for the Class select 

Systematic Random Sampling.  In these last two steps you are selecting a design based on line 

transects and transects will be created systematically (parallel and equally spaced), but placed at 
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a random starting point within the sampling frame, which satisfies the assumption of random 

placement of transects relative to survey objects.  

 

Next, select the Properties button to the right.  First go to the Effort Allocation tab.  Under 

Edge sampling, select Minus. This forces transects to fall within the sampling frame and 

assumes objects are not biased toward the edge of the sampling frame. Alternatively, Plus 

sampling overlaps transects on the edge of the sampling frame to compensate for any potential 

bias of edge.  If you use the Plus edge sampling, your design will include transects outside the 

sampling frame that must be edited out later.  Next, under the Allocation by stratum tab select 

Absolute values for “line length”.  Under Length, enter the total length (in meters) of sampling 

effort derived from pilot surveys for your desired degree of precision (CV).   The default angle is 

“0”, which means that transects will be oriented east-west.  If you prefer to have transects 

oriented differently, e.g., north-south, change the angle to “90”. We have found that orienting 

transects either east-west or north-south makes navigation in the field simple. 

 

Next go to the Sampler tab.  The default Line sampler width units should be Meter.  Under the 

By stratum properties, replace the default Width of “1” with “20”.  The 20 m Width is an 

approximation of half the width of a transect.  Program Distance uses this value to calculate an 

estimate of the coverage probability for your survey (the expected proportion of the sampling 

frame you would survey using this particular design). Select OK to save the Design properties. 

Select Run on the top right side of the page and OK to generate the design.  Close the Design 

page.   

 

To create a shape file of the transects based on your design go to the Surveys tab to the right of 

the Designs tab.  Under Surveys, select the New survey icon and you will see that a New 

Survey line has been added to the main screen.  Double click the gray ball next to ID or select 

the Show details for selected survey icon. Name the Survey, “transect”.  Under Design, select 

Set 1 (the default), and [1] conventional.  Select the Run button and OK.  Page through the 

Design output by selecting Next at the top right of the Design engine output screen. These 



 

 

 

 

 

 

16 

screens provide a summary of the details of the design as well as a map showing the grid cells 

and a list of the X, Y coordinates of the start and end points for your transects. Close out of the 

Surveys page.  

 

5. Displaying your transects in Program Distance 
 

The next step is to add the “transect” layer to your map.  Go to the Maps tab on the Project 

Browser and select the View Map button.  Select the Add Layer to Map icon.  Use the pull 

down tab on the Add Map Layer window and select “transect”.  Then hit the OK button and 

close the Maps window. Select Yes to save changes. The “transect” shape file is automatically 

saved in the “Balfour_design.dat” folder.  This shape file can be added to your ArcGIS project 

using the Add Data tool found within ArcGIS.  You will need to define the projection if you use 

the shape file in an ArcPad project on a Nomad GPS. 
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Creating Designs for Special Cases 

 

1. Repeated Sampling Design 
 

A repeated sampling design is appropriate when you have a site with low tortoise density or a 

very small to medium-sized site where you might not have enough detections to obtain a 

population estimate with reasonable precision. With a repeated design, you can increase the 

number of detections either by 1) sampling the same transects more than once, using different 

survey crews to obtain independent samples or 2) sampling two sets of perpendicular transects, 

which would allow independent samples of each set of transects.  As long as transects are 

sampled independently, it is acceptable to count the same tortoises twice.   

 

Repeat steps 1-3 from the Creating a Conventional Design instructions above. 

 

Start at Step 4 by designing a set of transects running east to west.   

 

To do so, go to the Designs tab.  Select the New Design icon and double click the gray ball next 

to ID or select the Show details for selected design icon and name this design “repeatEW”.  

Under the Type of Design, Sampler, select Line.  Below that, for Class, select Systematic 

Random Sampling.  Select the Properties button to the right.  First go to the Effort Allocation 

tab.  Under Edge Sampling, select Minus or Plus.  Next, under the Allocation by stratum, 

select Absolute values for “line length”.  Under Length, enter half the length (in meters) of 

sampling effort derived from pilot surveys for your desired degree of precision (CV).  The angle 

is the default, “0”, which means that transects will be oriented east-west.   

Next go to the Sampler tab.  The default Line sampler width units should be Meter.  Under the 

By stratum properties, replace the default Width of “1” with “20”.  The 20 m Width is an 

approximation of half the width of a transect.  Program Distance uses this value to calculate an 

estimate of the coverage probability for your survey (the expected proportion of the sampling 

frame that you would survey using this particular design). Next, select the Coverage Probability 

tab. Under Results Coverage grid, use the default Grid field name, “repeatEW”. Select OK to 
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save the Design Properties. Select Run on the top right side of the page and OK to generate the 

design.  Close the Design page.   

 

Now you need to create a second design that includes transects that run north to south.  Within 

the Designs tab, select the New Design icon and double click the gray ball next to ID or select 

the Show details for selected design icon. Name this design “repeatNS”. Under the Type of 

Design, Sampler, select “Line”.  Below that, for the Class, select Systematic Random 

Sampling. Select the Properties button to the right.  First go to the Effort Allocation tab.  

Under Edge Sampling, select Minus or Plus.  Next, under the Allocation by stratum, select 

Absolute values for “line length”.  Under Length, enter half the length (in meters) of 

sampling effort derived from pilot surveys for your desired degree of precision (CV).  Change 

the default angle from “0” to “90”, so that transects will be oriented north-south.   

 

Next go to the Sampler tab.  The default Line sampler width units should be Meter.  Under the 

By stratum properties, replace the default Width of “1” with “20”.  Next, select the Coverage 

Probability tab. Under Results Coverage grid, change the Grid field name to “repeatNS”. 

Select OK to save the Design Properties. Select Run on the top right side of the page and OK to 

generate the design.  Close the Design page. 

 

Next, you need to run the survey for the east-west transects. Select the Surveys tab to the right of 

the Designs tab.  Select the New survey icon and you will see that a New Survey line has been 

added to the main screen.  Double click the gray ball next to ID or select the Show details for 

selected survey icon. Name the Survey, “EWtran”.  Under Design, select Set 1, [1] repeatEW.  

Select the Run button and OK.  Page through the Design output by selecting Next at the top 

right of the Design engine output screen. Close the survey page. 

 

Next you need to run the survey for the north-south transects. Within the Surveys tab.  Select the 

New survey icon and you will see that a New Survey line has been added to the main screen.  

Double click the gray ball next to ID or select the Show details for selected survey icon. Name 
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the Survey, “NStran”.  Under Design, select Set 1, [2] repeatNS.  Select the Run button and 

OK.  Page through the Design output by selecting Next at the top right of the Design engine 

output screen. Close the survey page. 

 

5. Displaying your transects in Program Distance 
 

The next step is to add the transect layers to your map.  Go to the Maps tab on the Project 

Browser and select the View Map button.  Select the Add Layer to Map icon.  Use the pull 

down tab on the Add Map Layer window and select “EWtran” followed by OK.  Again, select 

the Add Layer to Map icon and use the pull down tab under the Add Map Layer window and 

select “NStran”.  Then hit the OK button and close the Maps window. Select Yes to save 

changes. Both the “EWtran” and the “NStran” transect shape files are automatically saved in 

the “filename.dat” folder.  These transect shape files can be added to your ArcGIS project using 

the Add Data tool.  You will need to define the projection in ArcGIS if you use the shape files in 

an ArcPad project on a Nomad GPS. 
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2. Systematic Segmented Grid Sampling Design 
 

A Systematic Segmented Grid Sampling design is appropriate for large sites (~10,000 ha) with 

somewhat heterogeneous habitat.  This design randomly superimposes a systematic set of 

segmented parallel lines onto the sampling frame.  More, shorter transect lines (samplers) yield 

more precise estimates of the encounter rate variance, and thus more precise population estimates 

than a design with few longer transects.  

 

Repeat steps 1-3 from the Creating a Conventional Design instructions above. 

 

Start at Step 4 by designing transects using systematic segmented grid sampling.  

To do so, go to the Designs tab.  Select the New Design icon and double click the gray ball next 

to ID or select the Show details for selected design icon and name this design “segmented”.  

Under the Type of Design, Sampler, select Line.  Below that, for the Class, select Systematic 

Segmented Grid Sampling.  Select the Properties button to the right.  First go to the Effort 

Allocation tab.  Under Edge Sampling, select Minus or Plus.  Under Sampler segment 

handling, select Allow split samplers. Next, under the Allocation by stratum, select, 

Systematic line spacing, and check the box to the right for Same spacing between segments 

and lines.  Where possible, it is best to create transects that are equally spaced between segments 

and lines, so that individual segments can be assumed to be independent when calculating 

variances.  It is important to note that on large sites, you will generally have to increase 

your sampling effort above what was calculated from the pilot survey, to obtain a 

reasonable Coverage probability. Therefore, in the table at the bottom of the Effort Allocation 

tab, enter  values under Spacing and Segment that produce a total Length (in meters) of the 

sampling effort that is equal to or greater than what was derived from pilot surveys for your 

desired degree of precision (CV).  The default Angle is “0”, which means that transects will be 

oriented east-west.  If you prefer to have the transects oriented north-south, change the angle to 

“90”.  

Next go to the Sampler tab.  The default Line sampler width units should be Meter.  Under the 

By stratum properties, replace the default Width of “1” with “20”.  The 20 m Width is an 
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approximation of half the width of a transect.  Program Distance uses this value to calculate an 

estimate of the coverage probability for your survey (the area you would survey using this 

particular design). Select OK to save the design properties. Select Run on the top right side of 

the page and OK to generate the design.  After generating the design, look at the Design engine 

output and decide if the Approximated Coverage probability is acceptable.  If not, re-design 

the survey with increased Sampling Effort.  Once you are satisfied with the design, close out of 

the Design page.   

 

Next, you need to run the survey for the Systematic Segmented Grid Sampling. Select the 

Surveys tab to the right of the Designs tab.  Select the New survey icon and you will see that a 

New Survey line has been added to the main screen.  Double click the gray ball next to ID or 

select the Show details for selected survey icon. Name the Survey, “segtran”.  Under Design, 

select Set 1, [1] segmented.  Select the Run button and OK.  Page through the Design output by 

selecting Next at the top right of the Design engine output screen. Close the survey page. 

 

5.Displaying your transects in Program Distance 
 

The next step is to add the “segtran” layer to your map.  Go to the Maps tab on the Project 

Browser and select the View Map button.  Select the Add Layer to Map icon.  Use the pull 

down tab on the Add Layer window and select “segtran”.  Then hit the OK button and close the 

Maps window. Select Yes to save changes. The “segtran” shape file is automatically saved in 

the “filename.dat” folder.  This shape file can be added to your ArcGIS project using the Add 

Data tool.  You will need to define the projection if you use the shape file in an ArcPad project 

on a Nomad. 
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APPENDIX II 

 
INSTRUCTIONS FOR LTDS SURVEY 

ANALYSES USING PROGRAM 

DISTANCE 6.2 
 

 

 Conventional (CDS) Analysis (Pages 23-39) 

 Multiple Covariate Distance Sampling  (MCDS) 

Analysis (Pages 30-35) 

 Model Selection (Page 35) 
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Conventional Distance Sampling (CDS) Analysis Engine 

 

The Conventional Distance Sampling analysis engine is appropriate for surveys with up to one 

level of stratification (e.g., geographic stratification) and uses one covariate, observed distance, 

but does not allow additional covariates such as burrow diameter.  

 

1. Data Management in ArcGIS 

It is important to proof field data carefully.  For data collected in ArcPad, carefully review the 

data within the attribute tables for the “start_end points” and “tortoise_observation” shape 

files. Check for missing start/end points on transects. Ensure that all points within both of these 

shape files correspond to the correct transect number.  

 

Each transect must be uniquely identified, including fragments of transects that may have been 

separated by unsuitable habitat or fell within disjunct polygons in the sampling frame. Transects 

and transect fragments can be uniquely labeled in the field, or you can add a new field for unique 

labels in the “start_end points” shape file.  To do so, open the attribute table for “start_end 

points.shp”, sort by transect ID, select the Options at the bottom right of the window.  Select 

add a new field named “tran_segment”. Next, start editing “start_end points.shp” and enter a 

unique segment ID for each pair of consecutive points [e.g. tran_segment = (1.1, 1.1); (1.2, 1.2); 

(1.3, 1.3); for 3 pairs of consecutive points taken while surveying transect #1]. 

 

Next, create a new transect shape file that represents the actual length of transects surveyed.  

This step is necessary if you designed the survey using Plus sampling, where the ends of 

transects that fell outside the sampling frame were surveyed, or if sections of transects that 

passed through unsuitable habitat within the sampling frame were clipped out in the field. To do 

so, in ArcGIS, convert features from a points shapefile (“start_end points”) to a line shapefile 

(name it “actual_transects”) and group by the field, “tran_segment”.  Calculate the transect 

lengths and export as “transect_lengths.dbf”. 
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Next, assign the appropriate “tran_segment” ids to observations within the 

“tortoise_observations” shapefile. 

 

Next, calculate the perpendicular distances from “tortoise_observations.shp” to 

“actual_transects” using the NEAR tool in the Arctoolbox and export data as 

“tortoise_observations.dbf” (unoccupied burrows are not included for tortoise density estimates 

and you will edit these out in the next step). 85˚ to 95˚ is an acceptable range for angles 

calculated from the NEAR analysis; angles outside this range indicate that burrows were outside 

the sampling frame and they should be excluded from the analysis. 

 

 

 

2. Data Management in Excel 

In Excel, create “distance_input.csv” that combines data from “transect_lengths.dbf” and 

“tortoise_observations.dbf” (remember to delete unoccupied burrows from this csv file) and 

format data following the example below: 

Example             

Label Area (ha) Transect ID Length (m) Perpdistance 

(m) 

Ichauway 12000 1.1 1284.8 5.6 

  1.2 568.2  

  1.3 854.3 19.2 

    15.2 

  2.1 525 2.3 
*Note: Transect ID 1.3 had 2 tortoise observations. One at 19.2 m from the transect and one at 15.2 m. 

“Label” = Site name 

 “Area” = Area of sampling frame (ha) 

 “Transect ID” = tran_segment IDs (include all transects, even those with no tortoises) 

 “Length” = tran_segment lengths (m) 

“Perpdistance” = Perpendicular distance (m) from tran_segments to 

tortoise_observations (Leave blank if no tortoises observed on transect; remember to 

delete all unoccupied burrows) 
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3. Data Import into Distance 

To import your data into Program Distance for analysis, you first need to create a new Project. 

A New Project Setup Wizard will guide you through the following steps to ensure that your 

data (“distance_input.csv”) is read into the program properly.  

 

Open Program Distance. From the main menu, select the File tab and select New Project. In the 

Create Project Window, enter your file name. After naming your file and choosing a location, 

select the Create button. Use the New Project Setup Wizard to complete project setup; Step 1-

Type of Project: select “I want to: Analyze a survey that has been completed”, select Next 

button.  

 

Step 2- Setup for Analyzing a Survey: select the Next button.  

 

Step 3- Survey Methods: under Type of survey, use the default “Line transect”, under 

Observer configuration, choose the default “Single observer”. Choose this option if you are 

using only one group of observer(s) recording observations.  A double observer configuration 

would be chosen if you had a second group of observer(s) independently recording the 

observations that were missed. Under Distance measurements, use the default “Perpendicular 

measurements” (type of distances measured to tortoises). Under Observations, use the default 

“Single objects” (observations of single individuals). Select the Next button.  

 

Step 4- Measurement Units: Specify the following measurement units for your data: under 

Distance, select “Meter”. Under Transect length, select “Meter”. Under Area, select 

“Hectare”. Select the Next button.  

 

Step 5- Multipliers: Multipliers are constants used to scale the final density estimate (Distance 

6.2 Help Guide), i.e. if only one side of the transect was surveyed, you would add a sampling 

fraction of 0.5. For most cases, no multipliers are needed. Select the Next button.  
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Step 6-Finished: Under Destinations, select “Proceed to Data Import Wizard” to import data 

from an external file. Select the Finish button. This will open a new window. Navigate to the 

location of the “distance_input.csv” file containing data to import (Note: you must select “All 

files” under Files of type to list .csv files in window). Select OK.  The Import Data Wizard 

will open automatically to Step 3 after choosing your “distance_input.csv” file.  

 

Step 3-Data Destination: Next, you need to tell Distance where to store the imported data. 

Under Destination data layers, use the default Lowest data layer, “Observation”. This layer is 

the most specific or finest-scaled data layer (i.e., tortoise observations). Under the Highest data 

layer, select “Region”. This layer is your most general or largest scale data layer (i.e., Site 

name). Under Location of new records, select the default “Add all new records …..”. Under 

the Creation of new records in lowest data layer, select the default “Create one new record 

for each……..” Choosing these options will allow distance to format your data similarly to your 

distance_input.csv file. Select Next. 

 

Step 4- Date File Format: Here, you tell Distance what delimiters were used to separate the 

columns of your data (Distance 6.2 Help Guide). You can check that columns are being 

recognized correctly by looking at the preview of the table. Under delimiter, choose “Comma”.  

Tick the box under Ignore Rows to allow distance to ignore the first row of your 

“distance_input.csv” file.  This step is necessary if the first row of data in your .csv file contains 

column labels.  Select the Next button.  

 

Step 5- Data File Structure: Here, you tell Distance which columns in your data file correspond 

to fields in the Distance database (Distance 6.2 Help Guide).  Check the box under Shortcuts: 

“Columns are the same order…..” This will populate the proper Layer names, Field names, 

and Field types for each column. Layer name refers to the scale of the data, highest data layer 

(Region) to lowest data layer (observation). Field name can be a Label (Site name or transect 

ID), Area, Line Length, or Perp distance. Field type can be a Label (character) or Decimal 
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(numeric). Alternatively, you can also manually assign columns to fields, by clicking on the first 

and second row of grey boxes (Distance 6.2 Help Guide). Select the Next button.  

 

Step 6- Finished: under Existing data, select the default “Overwrite existing data” and then 

the Finish button to import your data into the Distance database. Select the Data tab.  Under 

Data layers, select “Observation”. This will allow you to see the contents of the Distance 

database. Verify that the data were imported correctly (i.e. correct number of tortoise 

observations, transects etc).  

 

 

4.  Defining models in Distance 

The next step is to define a series of models to tell Distance how to analyze the data. Model 

Definition options include the analysis engine to use, in this case, Conventional Distance 

Sampling, the type of detection function model (e.g., half-normal with cosine adjustments) and 

the method of estimating variance (analytic vs. bootstrap), among other things. The model 

definitions outlined below are those that are those most likely to fit an appropriate detection 

function for gopher tortoise survey data. 

 

In Distance, a model is composed of 2 parts: 1) Key functions: Half-normal, Uniform, and 

Hazard-rate and 2) Series Expansion functions: Cosine, Simple polynomial.  

It is important to add a data filter to the models that will discard outliers.  We typically filter 

(discard) the largest 5% of distances.  The model naming convention includes the Key function 

and data filter truncation (i.e. HN 5%).   

 

To define models in Distance, navigate to the Analyses tab in the Project Browser. Double click 

on the gray ball or Show details for selected analysis. First, you need to set up your data filter. 

Under Data filter, select the Properties button and navigate to the Truncation tab. Under 

Truncation of exact measurements/Right truncation, choose Discard the largest “5” percent 

of distances.  Under Left truncation, use the default “No left truncation”.  Left truncation is 
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used to truncate (remove) observations close to the transect that might be biased by observer 

presence (e.g. when conducting deer spotlight counts along a road and deer avoid the road 

[transect] because of the presence of a vehicle). Under Truncation for cluster size estimation/ 

Right truncation, choose the default “Same as that specified above”.  This option only applies 

to observations of clustered groups.  Change the Name to “discard 5%” and select OK. The 

next step is to define models.  

 

Analysis 1 (HN): under Model definition, select the Properties button. Under Analysis 

Engine, choose the default “CDS-Conventional distance sampling”. Navigate to the Detection 

function tab and select the Models tab. Under Detection function models, use the defaults for 

Key function (Half-normal) and Series expansion (Cosine).  Select the “plus” sign next to 

Series expansion and add Model 2: Key function (Half-normal), Series expansion (Simple 

polynomial). Select the Constraints tab, under Constraints on fitted function and select 

“weakly monotonically non-increasing.” Change the Name to “HN” and select OK.  

 

Analysis 2 (UN): under Model definition, select the New button. Under Analysis Engine, 

keep the default “CDS-Conventional distance sampling”. Navigate to the Detection function 

tab and select the Models tab. Under Detection function models, For Models 1 and 2, change 

the Key function to “Uniform”. Keep the Series expansion set as “Cosine” for Model 1 and 

“Simple polynomial” for Model 2.  Change the Name to “UN” and select OK. 

 

Analysis 3 (HR): under Model definition, select the New button. Under Analysis Engine, 

keep the default “CDS-Conventional distance sampling”. Navigate to the Detection function 

tab and select the Models tab. Under Detection function models, change the Key function to 

“Hazard-rate” Keep the Series expansion set as “Cosine” for Model 1 and “Simple 

polynomial” for Model 2. Change the Name to “HR” and OK. 
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5. Running Models in Distance 

You will run the following 3 analyses: 

 HN 5% 

 UN 5% 

 HR 5% 

 

To run the first analysis, change the Name at the top of the Analysis Browser to “HN 5%”. 

Under Data filter, select “discard 5%”. Under Model definition, select “HN”. Select the Run 

button next to Name. Page through the Results by clicking the Next button in the top right 

corner. Close the Results browser by selecting the bottom “X” in the top right corner.  

 

To run the second analysis, select the New Analysis icon. Double click the gray ball or select the 

Show details for selected analysis icon. Change the Name at the top of the Analysis Browser to 

“UN 5%”. Under Data filter, keep “discard 5%”. Under Model definition, change to “UN”. 

Select Run. Page through the Results and close the Results browser. 

 

To run the third analysis, select the New Analysis icon. Double click the gray ball or select the 

Show details for selected analysis icon. Change the Name at the top of the Analysis Browser to 

“HR 5%”. Under Data filter, keep “discard 5%”. Under Model definition, change to “HR”. 

Select Run. Page through the Results and close the Results browser. 

 

6. Model Summary 

The Model Summary is formatted like a spreadsheet, with one row for each model analysis and 

columns that give you useful information about the analyses (Distance 6.2 Help Guide). 

Columns of default parameters summarize the results (i.e. AIC, D). Additional parameters (i.e. 

N, P) can be added using the Add, remove, and arrange columns icon.   
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Multiple Covariate Distance Sampling (MCDS) Analysis Engine 

 

This analysis is appropriate to use when you have additional covariates that might influence 

detection of objects, e.g., the size of a burrow. This analysis engine contains (almost) all the 

features of the CDS engine, but also allows additional covariates to be included in the detection 

function model, in addition to observed distance.  These covariates are assumed to influence the 

scale of the detection function, but not its shape (User’s Guide Distance 6.2, Release 1, Chapter 

9). 

 

Repeat step 1 from the Conventional (CDS) Analysis instructions above. 

 

2.  Data Management in Excel 

In Excel, create “distance_input.csv” with data from “transect_lengths.dbf” and 

“tortoise_observations.dbf” and merge and format data similarly to the following example: 

  

 

Example             

Label Area (ha) Transect ID Length (m) Perpdistance 

(m) 

Diameter (cm) 

Ichauway 12000 1.1 1284.8 5.6 35 

  1.2 568.2   

  1.3 854.3 19.2 26 

    15.2 25 

  2.1 525 2.3 15 
*Note: Transect ID 1.3 had 2 tortoise observations. One at 19.2 m from the transect and one at 15.2 m. 

Label = Site name 

 Area = Area of sampling frame (ha) 

 Transect ID = tran_segment IDs (include all transects, even those with no tortoises) 

 Length = tran_segment lengths (m) 

 Perpdistance = Perpendicular distance (m) from tran_segments to tortoise_observations  

(leave blank if no tortoises observed on transect) 
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 Diameter = burrow diameter (cm) 

 

3. Data Import into Distance 

To import your data into the Distance program, you first need to create a new Project. A New 

Project Setup Wizard will guide you through the following steps to ensure that your data 

(“distance_input.csv”) is read into the program properly.  

 

Open Program Distance. From the main menu, select the File tab and select New Project. In the 

Create Project Window, enter your file name. After naming your file and choosing a location, 

select the Create button. Use the New Project Setup Wizard to complete project setup; Step 1-

Type of Project: select “I want to: Analyze a survey that has been completed”, select Next 

button.  

 

Step 2- Setup for Analyzing a Survey: select the Next button.  

 

Step 3- Survey Methods: under Type of survey, use the default “Line transect”, under 

Observer configuration, choose the default “Single observer”. Choose this option if you are 

using only one group of observer(s) recording observations.  A double observer configuration 

would be chosen if you had a second group of observer(s) independently recording the 

observations that were missed. Under Distance measurements, use the default “Perpendicular 

measurements” (type of distances measured to objects). Under Observations, use the default 

“Single objects” (observations of single individuals). Select the Next button. 

 

Step 4- Measurement Units: Specify the following measurement units for your data: under 

Distance, select “Meter”. Under Transect length, select “Meter”. Select the Next button.  

 

Step 5- Multipliers: Multipliers are constants used to scale the final density estimate (Distance 

6.2 Help Guide), i.e. if only one side of the transect was surveyed, you would add a sampling 

fraction of 0.5. For most cases, no multipliers are needed. Select the Next button.  
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Step 6-Finished: Under Destinations, select “Proceed to Import Data Wizard” to import data 

from an external file. Select the Finish button. This will open a new window. Navigate to the 

location of the “distance_input.csv” file containing data to import (Note: you must select “All 

files” under Files of type to list .csv files in window). Select OK.  The Import Data Wizard 

will open automatically to Step 3 after choosing your “distance_input.csv” file.  

 

Step 3- Data Destination: Next, you need to tell Distance where to store the imported data. 

Under Destination data layers, use the default Lowest data layer, “Observation”. This layer is 

the most specific or finest-scaled data layer (i.e tortoise observations). Under the Highest data 

layer, select “Region”. This layer is your most general or largest scale data layer (i.e. Site 

name). Under Location of new records, select the default “Add all new records …..” Under 

the Creation of new records in lowest data layer, select the default “Create one new record 

for each……..” Choosing these options will allow distance to format your data similarly to your 

distance_input.csv file. Select Next. 

 

Step 4- Date File Format: Here, you tell Distance what delimiters were used to separate the 

columns of your data (Distance 6.2 Help Guide). You can check that columns are being 

recognized correctly by looking at the preview of the table. Under delimiter, choose “Comma”.  

Tick the box under Ignore Rows to allow distance to ignore the first row of your 

“distance_input.csv” file.  This step is necessary if the first row of data in your .csv file contains 

column labels.  Select the Next button.  

  

Step 5- Data File Structure: Here, you tell Distance which columns in your data file correspond 

to fields in the Distance database (Distance 6.2 Help Guide).  Tick the box under Shortcuts: 

“Columns are the same order…..” This will populate the proper Layer names, Field names, 

and Field types for each column. Layer name refers to the scale of the data, highest data layer 

(Region) to lowest data layer (observation). Field name can be a Label (Site name or transect 

ID), Area, Line Length, or Perp distance. Field type can be a Label (character) or Decimal 
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(numeric). Covariates will not automatically populate the Data File Structure. Therefore, for 

“Diameter”, you must manually assign “Observation” under Layer name, type in “Diameter” 

under Field name, and select “Integer” for Field type, by clicking on the first and second row 

of grey boxes. Select the Next button.  

 

Step 6- Finished: under Existing data, select the default “Overwrite existing data” and then 

the Finish button to import your data into the Distance database. Select the Data tab.  Under 

Data layers, select “Observation”. This will allow you to see the contents of the Distance 

database. Verify that the data were imported correctly (i.e. correct number of tortoise 

observations, transects etc).  

 

4.  Defining models in Distance 

The next step is to define the models that will be used for the analysis. In Distance, a model is 

composed of 2 parts: 1) Key functions: Half-normal, and Hazard-rate and 2) Series Expansion 

functions: Cosine, Simple polynomial.  It’s important to add a data filter to the models that will 

discard outliers.  Notice that only 2 key functions are available in MCDS models. We typically 

filter (discard) the largest 5% of distances.  The model naming convention includes the Key 

function, and data filter truncation (i.e., HN 5%).   

 

To define models in Distance, navigate to the Analyses tab in the Project Browser. Double click 

on the gray ball or Show details for selected analysis. First, you need to set up your data filter. 

Under Data filter, select the Properties button and navigate to the Truncation tab. Under 

Truncation of exact measurements/Right truncation, choose Discard the largest “5” percent 

of distances.  Under Left truncation, use the default “No left truncation”.  Left truncation is 

used to truncate (remove) observations close to the transect that might be biased by observer 

presence (e.g. when conducting deer spotlight counts along a road and deer avoid the road 

[transect] because of the presence of a vehicle). Under Truncation for cluster size estimation/ 

Right truncation, choose the default “Same as that specified above”.  This option only applies 
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to observations of clustered groups.  Change the Name to “discard 5%” and select OK. The 

next step is to define models.  

 

Analysis 1 (HN): under Model definition, select the Properties button. Under Analysis 

Engine, choose “MCDS-Multiple covariates distance sampling”. Navigate to the Detection 

function tab and select the Models tab. Under Detection function models, use the defaults for 

Key function (Half-normal) and Series expansion (Cosine). *Note that the MCDS analysis 

engine does not allow constraints. Select the Covariates tab. Under Detection function 

covariates, select the Plus button. Under Layer type containing covariate, select 

“Observation”. Under Field name of covariate, select “Diameter”. Change the Name to “HN” 

and select OK.  

 

Analysis 2 (HR): under Model definition, select the New button. Under Analysis Engine, 

keep “MCDS-Multiple covariates distance sampling”. Navigate to the Detection function tab 

and select the Models tab. Under Detection function models, Change the Key function to 

“Hazard-rate”. Keep the Series expansion set as “Cosine”.  Change the Name to “HR” and 

select OK. 

 

5. Running Models in Distance 

In MCDS, there are only two key functions available.  You will run the following 2 analyses: 

 HN 5% 

 HR 5% 

 

To run the first analysis, change the Name at the top of the Analysis Browser to “HN 5%”. 

Under Data filter, select “discard 5%”. Under Model definition, select “HN”. Select the Run 

button next to Name. Page through the Results by clicking the Next button in the top right 

corner. Close the Results browser by selecting the bottom “X” in the top right corner.  
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To run the second analysis, select the New Analysis icon. Double click the gray ball or select the 

Show details for selected analysis icon. Change the Name at the top of the Analysis Browser to 

“HR 5%”. Under Data filter, keep “discard 5%”. Under Model definition, change to “HR”. 

Select Run. Page through the Results and close the Results browser. 

 

6. Model Summary 

The Model Summary is formatted like a spreadsheet, with one row for each analysis and 

columns that give you useful information about the analyses (Distance 6.2 Help Guide). 

Columns of default parameters summarize the results (i.e. AIC, D). Additional parameters can 

be added using the Add, remove, and arrange columns icon (i.e. N, P).  

 

7. Model Selection 

Program Distance uses an information theoretic approach to model selection (Burnham and 

Anderson 2002).  The model summary table includes both Akaike's Information Criterion (AIC) 

and Delta AIC values for the suite of models.  Generally, the model with the lowest AIC is 

considered the best model, but all models with an AIC < 2 units from the best model are 

competitive.  However, be sure to review all output pages for each competing model.  In 

particular, check for error warnings, which would appear under “Log messages.” Among 

competing models, we generally select the model with the lowest CV.  However, we strongly 

recommend reviewing Burnham and Anderson (2002) and Buckland et al.  (2001; Chapter 8) for 

information on model selection in Program Distance.  
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